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RECALIBRATION

Your Alicat instrument is a precision device and Alicat strongly
recommends that you send it to us on a yearly basis for recalibration.

A yearly recalibration does a few things:
P Itinsures that your unit is functioning according to specification.

» Contamination may cause the instrument to measure flow
improperly. Recalibration insures the instrument is clean and free
from debris.

» Recalibration maintains your LIFETIME WARRANTY!

Sending your unit for recalibration is easy and inexpensive. Recalibrations
are usually shipped within five days of receipt, so it’s fast too.

Please keep the original box to return your Alicat instrument for recalibration.

For more information regarding recalibration see page 34.

ACCESSORIES

Now that you have your Alicat instrument are you sure you've got
everything you need? Alicat accessories can make your job easier.

Many of our customers also order:

» Power Supplies — A universal wall power supply that makes it easy
to power your Alicat unit just about anywhere in the world.

» BB9 — Alicat’s multi-drop box that allows easy connection of up to
nine Alicat instruments to a single USB, RS-232 or RS-485 port.

» MD8DB9 — An RS-232 to 8 pin Mini-DIN cable to connect your
Alicat instrument to a computer. A variety of other cables are also
available.

» Flow Vision™ SC — A GUI based Windows®program that allows easy
computer access and control for one or multiple Alicat instruments.

P Fittings and filters — Keep your instrument properly connected to
your process and free from harmful contamination.

See pages 39-42 for a complete description and list of Alicat accessories.
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Thank you for purchasing an Alicat Gas Flow Meter.

Please take the time to read the information contained in this manual. This will
help to ensure that you get the best possible service from your instrument. This
manual covers the following Alicat Scientific instruments:

M-Series Mass Gas Flow Meters
WHISPER Low Pressure Drop Mass Flow Meters
MS-Series Mass Gas Flow Meters
MS-Series Flow Meters are for use with certain aggressive gases (see page 59).

This includes M-Series devices labeled as approved for CSA Class 1 Div 2 and
ATEX Class 1 Zone 2 hazardous environments. See pages 79 and 80 for Special
Conditions regarding the use of CSA/ATEX labeled devices.

MB-Series Portable Mass Gas Flow Meters
WHISPER Portable Low Pressure Drop Mass Gas Flow Meters

All MB-Series and Whisper Portable Gas Flow Meters operate in accordance
with the instructions found in this manual. Please see page 38 for information
regarding portable meter operation.

Unless otherwise noted, the instructions in this manual are applicable to all of
the above instruments.

Full specifications for each device can be found on pages 50 through 64.

Please contact Alicat at 1-888-290-6060 or info@alicat.com if you have
any questions regarding the use or operation of this device.

Many Alicat meters are built for specific applications. Two meters with

the same flow range and part number may look and act quite differently
depending upon the application the meter was built for. Care should be
taken when moving a meter from one application to another.

You can find a number of instructional videos related to the
operation of this device by visiting the Alicat web site or scanning
the QR code below.
http://www.alicat.com/support/instructional-videos/
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GETTING STARTED

Power Jack 8 Pin Mini-DIN
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Medium Mass Flow Meter
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MOUNTING

M-Series Gas Flow Meters have holes on the bottom for mounting to flat
panels. See pages 50-64.

M-Series Meters can usually be mounted in any position.
No straight runs of pipe are required upstream or downstream of the meter.
PLUMBING

Your meter is shipped with plastic plugs fitted in the port openings. To
9 lessen the chance of contaminating the flow stream do not remove
these plugs until you are ready to install the device.

Make sure that the gas will flow in the direction indicated by the flow arrow.

Standard M-Series Gas Flow Meters have female inlet and outlet port
connections. Welded VCR and other specialty fittings may have male ports.

The inlet and outlet port sizes (process connections) for different flow ranges
are shown on pages 50-64.

Meters with M5 (10-32) ports have O-ring face seals and require no sealant or
tape. Do not use tape with welded or O-ring fittings.

For non M5 (10-32) ports use thread sealing Teflon® tape to prevent leakage
around the port threads.

Do not wrap the first two threads. This will minimize the possibility of getting
tape into the flow stream and flow body.

Do not use pipe dopes or sealants on the process connections as these
compounds can cause permanent damage to the meter should they get
into the flow stream.



9 We recommend the use of in-line sintered filters to prevent large
particulates from entering the measurement head of the instrument.
Suggested maximum particulate sizes are as follows:

5 microns for units with FS flow ranges of 0-1 sccm or less.
20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

Connecting Fittings and Filters
http://www.alicat.com/support/instructional-videos/

PRESSURE
Maximum operating line pressure for M-Series units is 145 psig (1 MPa).

If the line pressure is higher than 145 psig (1 MPa), use a pressure regulator
upstream from the flow meter to reduce the pressure to 145 psig (1 MPa) or less.

Maximum operating line pressure for WHISPER units is 50 psig.

a Exceeding the maximum specified line pressure may cause permanent
damage to the solid-state differential pressure sensor.

Do NOT SUBJECT AN M-SERIES DIFFERENTIAL PRESSURE SENSOR TO
UPSTREAM-DOWNSTREAM PRESSURE DIFFERENTIALS EXCEEDING 75 PSID.

Do NoT SUBJECT A WHISPER DIFFERENTIAL PRESSURE SENSOR TO
UPSTREAM-DOWNSTREAM PRESSURE DIFFERENTIALS EXCEEDING 15 PSID.

While high static pressure will typically not damage the dp sensor, sudden
pressure “spikes” can result in complete failure of the sensor.

A common cause of this problem is instantaneous application of
high-pressure gas as from a snap acting solenoid valve either upstream
or downstream of the meter. If you suspect that your pressure sensor is

damaged please discontinue use of the meter and contact Alicat.




POWER AND SIGNAL CONNECTIONS

Power can be supplied to your meter through either the power jack (power jack not
available on CSA/ATEX approved devices) or the 8 pin Mini-DIN connector.

An AC to DC adapter which converts line AC power to DC voltage and current as
specified below is required to use the power jack.

Meters require a 7-30 Vdc power supply with a 2.1 mm female positive center
plug capable of supplying at least 100mA.

Note: 4-20mA analog output requires at least 15 Vdc.

Standard 8 Pin Mini-DIN Pin-Out

Pin |Function Mini-DIN
cable color
1 | Not Connected (or optional 4-20mA Primary Output Signal) Black
) Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, Brown

5Vdc, 10Vdc) or Basic Alarm]

3 | Serial RS-232RX / RS-485(—) Input Signal (receive) Red

Meters/Gauges = Remote Tare (Ground to Tare)

4 Controllers = Analog Set-Point Input Orange
5 | Serial RS-232TX / RS-485(+) Output Signal (send) Yellow
6 |0-5Vdc (or optional 0-10 Vdc) Output Signal Green
7 | Power In (as described above) Blue

3 Ground (common for power, digital communications, analog signals Purple

and alarms)
Note: The above pin-out is applicable to all the flow meters and controllers with the
Mini-DIN connector. The availability of different output signals depends on the options
ordered. Optional configurations are noted on the unit’s calibration sheet.

CAUTION! Do NOT CONNECT POWER TO PINS 1 THROUGH 6 AS PERMANENT
DAMAGE CAN OCCUR!

It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that reflects
the system bus voltage and can be used as a source for the set-point signal.

For 6 Pin Locking Industrial Connector, DB9, and DB15 Pin-outs, see pages
66 to 78. For PROFIBUS Pin-out, see page 64

8



INPUT SIGNALS
Analog Input Signal
Apply analog input to Pin 4 as shown on page 8.

For 6 Pin Locking Connector, DB9 and DB15 Pin-outs, see pages 66 to 78.
For PROFIBUS Pin-out, see page 64.

Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input
signal to pin 4, with common ground on pin 8.

Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be
applied to pin 4, with common ground on pin 8.

Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be
applied to pin 4, with common ground on pin 8.

NOTE: This is a current sinking device. The receiving circuit is essentially a
250 ohm resistor to ground.

NOTE: 4-20 mA output requires at least 15 Vdc power input.

SYSTEMS, AS THIS WILL DESTROY PORTIONS OF THE CIRCUITRY AND VOID
THE WARRANTY. IF YOU MUST INTERFACE WITH EXISTING LOOP POWERED
SYSTEMS, ALWAYS USE A SIGNAL ISOLATOR AND A SEPARATE POWER SUPPLY.

2 CAUTION! DO NOT CONNECT THIS DEVICE TO “LOOP POWERED"”

Electrical Connections and Basic Wiring
http://www.alicat.com/support/instructional-videos/
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9 A remote tare can be achieved by momentarily grounding pin 4 to tare
as shown above.




RS-232 / RS-485 Digital Input Signal

To use the RS-232 or RS-485 input signal, connect the RS-232 / RS-485 Output
Signal (Pin 5), the RS-232 / RS-485 Input Signal (Pin 3), and Ground (Pin 8) to
your computer serial port as shown below. (See page 25 for details on accessing
RS-232 / RS-485 input.)

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector
9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin

5 Ground Ground 8

3 Transmit Receive 3

2 Receive Transmit 5

DB9 to Mini-DIN Connection for RS-232 / RS-485 Signals

Communication Set Up
http://www.alicat.com/support/instructional-videos/
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OUTPUT SIGNALS
RS-232 / RS-485 Digital Output Signal

To use the RS-232 or RS-485 output signal, it is necessary to connect the RS-232
/ RS-485 Output Signal (Pin 5), the RS-232 / RS-485 Input Signal (Pin 3), and
Ground (Pin 8) to your computer serial port as shown on page 8. (See page 25
for details on accessing RS-232 / RS-485 output.)

Standard Voltage (0-5 Vdc) Output Signal

M-Series flow meters equipped with a 0-5 Vdc (optional 0-10 Vdc) will have this
output signal available on Pin 6. This output is generally available in addition to
other optionally ordered outputs. This voltage is usually in the range of 0.010
Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is linear
over the entire range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your meter was ordered with a 0-10 Vdc output signal, it will be available on
Pin 6. (See the Calibration Data Sheet that shipped with your meter to determine
which output signals were ordered.) This voltage is usually in the range of 0.010
Vdc for zero flow and 10.0 Vdc for full-scale flow. The output voltage is linear over
the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your meter was ordered with a 4-20 mA current output signal, it will be
available on Pin 1. (See the Calibration Data Sheet that shipped with your meter
to determine which output signals were ordered.) The current signal is 4 mA at
0 flow and 20 mA at the meter’s full scale flow. The output current is linear over
the entire range. Ground for this signal is common on Pin 8. (Current output
units require 15-30Vdc power.)

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See
the Calibration Data Sheet that shipped with your meter to determine which
output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or

4-20 mA analog signal that can represent any measured parameter. With this
optional output, a meter could output the mass flow rate (0-5 Vdc on pin 6) and
the absolute pressure (0-5 Vdc on pin 2).

9 If your device is CSA/ATEX approved or equipped with the optional six pin
industrial connector, please contact Alicat.

SYSTEMS, AS THIS WILL DESTROY PORTIONS OF THE CIRCUITRY AND VOID
THE WARRANTY. IF YOU MUST INTERFACE WITH EXISTING LOOP POWERED
SYSTEMS, ALWAYS USE A SIGNAL ISOLATOR AND A SEPARATE POWER SUPPLY.

2 CAUTION! Do NOT CONNECT THIS DEVICE TO “LOOP POWERED"”
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SYSTEMS, AS THIS WILL DESTROY PORTIONS OF THE CIRCUITRY AND VOID
THE WARRANTY. IF YOU MUST INTERFACE WITH EXISTING LOOP POWERED
SYSTEMS, ALWAYS USE A SIGNAL ISOLATOR AND A SEPARATE POWER SUPPLY.

2 CAUTION! Do NOT CONNECT THIS DEVICE TO “LOOP POWERED"”
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Female Serial Cable Front

Typical Multiple Device (Addressable) Wiring Configuration

9 The easiest way to connect multiple devices is with a Multi-Drop Box
(see page 46).
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Information for Alicat TFT (Color Display) Instruments

Alicat TFT (color display) instruments have a high contrast back-lit LCD display.
TFT instruments operate in accordance with Alicat standard operating instructions
for our monochrome menus and displays with the following differences.

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating
under normal conditions.

RED: The color of a parameter is displayed in red when operating
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the
monochrome display.
LCD Contrast:

LCD contrast is ranged from 1 to 11 on color displays with 11 being the greatest
contrast.

Display On/Off:
Pushing the button under the Alicat name will turn the device display on or off.
This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Alicat TFT (color display) meters,
gauges and controllers only. All other operating specifications are shown in the
Technical Data page for standard Alicat instruments. All standard device features
and functions are available and operate in accordance with the Alicat operating
manual provided with the device.

Specification Meter or Small Valve Large Valve
Gauge Controller Controller
Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vvdc 290 mA @ 12Vdc 780 mA @
70 mA @ 24Vdc 200 mA @ 24Vdc 24vdc

13



DISPLAYS AND MENUS

The device screen defaults to Main display as soon as power is applied to the meter.

Main

PSIA °C TARE ¥

+13.668 +21.58

+i, B

+3.808 MEHLL~
SCCH TOTAL

+E1 EiEiEi

Totalizer (option only)

TDTHL/ SCEH

AER.00

BREGE:AE:08

BACK RESET

Select Menu

MFG R5232
DATA COMM

The Main display shows pressure,
temperature, volumetric flow and mass
flow.

Pressing the button adjacent to a
parameter will make that parameter
the primary display unit.

By hitting the MENU button at the
bottom right of the screen you will
enter the Select Menu display.

If your meter was ordered with the
Totalizer option (page 43), pushing the
TOTAL button once will bring up the
Totalizing Mode display. Pushing MENU
will bring up the Select Menu display.

Select Menu

From Select Menu you can change
the selected gas, interact with your
RS-232 / RS-485 settings or read
manufacturer’s data.

Push MAIN to return to the Main display.

14



This mode defaults on power up, with
mass flow as the primary displayed
parameter.

°C
+13.66 +21.50

The following parameters are displayed in
the Main mode.

+E| El g;cm Gas Absolute Pressure: This sensor

. i references hard vacuum and reads
incoming pressure both above and below
+3.008 +B8.800 local atmospheric pressure. This parameter
CCH is moved to the primary display by pushing
the button above PSIA.

The engineering unit associated with
absolute pressure is pounds per square
inch absolute (psia). This can be converted to gage pressure (psig) by subtracting
local atmospheric pressure from the absolute pressure reading:

PSIG = PSIA — (Local Atmospheric Pressure)

Gas Temperature: M-Series flow meters
measure the incoming temperature of the
gas flow. The temperature is displayed

DO MODE in degrees Celsius (°C). This parameter is
moved to the primary display by pushing
the button above °C.

Pushing the button again allows you to
select °C (Celsius), °K (Kelvin), °F (Fahrenheit)
or °R (Rankine) for the temperature scale.
To select a temperature scale, use the UP
and DOWN buttons to position the arrow in
front of the desired scale.

Press SET to record your selection and return
to the MAIN display. The selected temperature scale will be displayed on the screen.

Tare: Pushing the TARE V button tares the flow meter and provides it with a
reference point for zero flow. This is an important step in obtaining accurate
measurements. It is best to zero the flow meter each time it is powered up. If
the flow reading varies significantly from zero after an initial tare, give the unit a
minute or so to warm up and re-zero it.
If possible, zero the unit near the expected operating pressure by positively blocking
the flow downstream of the flow meter prior to pushing the TARE button.
> Zeroing the unit while there is any flow will directly affect the accuracy
by providing a false zero point. If in doubt about whether a zero flow
condition exists, remove the unit from the line and positively block both ports
before pressing the TARE button. If the unit reads a significant negative value

15



when removed from the line and blocked, it was given a false zero. It is better
to zero the unit at atmospheric pressure and a confirmed no flow condition
than to give it a false zero under line pressure.

Volumetric Flow Rate: This parameter is located in the lower left of the display.
It is moved to the primary display by pushing the button below CCM in this
example. Your display may show a different unit of measure.

Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a

standard temperature and pressure (typically 14.696 psia and 25 °C).

This parameter is located in the lower middle of the display. It can be moved to

the primary display by pushing the button below SCCM in this example. Your

display may show a different unit of measure preceded by the letter S.

To get an accurate volumetric or mass flow rate, the gas being measured
must be selected. See Gas Select, page 18.

MENU: Pressing MENU switches the screen to the Select Menu display.

VOV = volumetric overrange, POV = pressure overrange, TOV =

temperature overrange) flashes when a measured parameter exceeds

the range of the sensor. When any item flashes, neither the flashing
parameter nor the mass flow measurement is accurate. Reducing the value of
the flashing parameter to within specified limits will return the unit to normal
operation and accuracy.

2 Flashing Error Message: An error message (MOV = mass overrange,

If the unit does not return to normal operation contact Alicat.

16




SELECT MENU

From Select Menu you can change the selected gas, interact with your
RS-232 / RS-485 settings or read manufacturer’s data.

Press the button next to the desired operation to bring that function to the screen.

MODEL
INFO

ALICAT SCIENTIFIC

MISC1 MISC2 Ph  520-298-6060

UNIT ID
Fax 528-298-018% A

Manufacturer Data

Miscellaneous,

Communications Select

MFG R5232
DATA COMM
up
>Recent.
Standard
Factory Custom
COMPOSER User Mixes

PSIA °C TARE Y
+13.68  +21.58

f ﬂ accn
+ ﬂ. J ir

+B.008  +0.000
CCH SCCM

Bioreactor
Breathing
Chronatography
Fuel

CANCEL

SELECT

DO

Gas Select

Select Menu

An explanation for each screen can be found on the following pages.

17



GAS SELECT

UF DOWH

*Recent

Standard

Factory Custom
COMPOSER User Mixes

Bioreactor
Breathing
Chromatography

PARGE

Gas Select allows you to set your
device to up to 150 standard gases and
mixes. You can also use COMPOSER to
program and store up to 20 additional
gas mixes.

Gas Select is accessed by pressing the
button below GAS SELECT on the Select
Menu display.

To select a gas, use the UP and DOWN

Fuel

CANCEL buttons to position the arrow in front of

the desired gas category.
»  Recent: Eight most recent selections
»  Standard: Gases and mixes standard
on earlier Alicat instruments (page 32)
»  Factory Custom: Present only if customer
requested gases were added at the factory
»  COMPOSER User Mixes: Gas mixes
programmed by the user (page 19)
DOWN PRGE »  Bioreactor (page 36)
>|_F;:elr~ »  Breathing (page 37)
02 Concentrator »  Chromatography (page 39)
Pure Corrosiuve »  Fuel (page 38)
Laser (page 38)
02 Concentrator (page 39)
»  Pure Corrosive* (page 33)
»  Pure Non-Corrosive (page 32)
»  Refrigerant* (page 34)
»  Stack (page 39)
»  Welding (page 35)

Fure Hon-Corrosive
Refrigerant »
Stack »
lelding

CAHCEL

Press PAGE to view a new page in the gas category list.

Press SELECT to view the gases in the selected category. Align the arrow with the
desired gas. Press SET to record your selection and return to the MAIN display.
The selected gas will be displayed on the screen.

* Pure Corrosive and Refrigerant gases are only available on S-Series instruments
that are compatible with these gases.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 32 -39 for a full list of gases in each category.

18



COMPOSER

Composer allows you to program
and save up to 20 custom gas mixes
containing 2 to 5 component gases

1P DOWN found in the gas lists (pages 32-39). The
#Hdd Mix: 26 Free minimum resolution is 0.01%.

Composer is accessed by selecting
COMPOSER User Mixes on the GAS
SELECT display.

Press SET when the arrow is aligned
CAMCEL with Add Mix.

Name the mix by pressing the UP and
DOWN buttons for letters, numerals
and symbols.

CHANGE CASE — Toggles the letter
case. Letters remain in selected case
until CHANGE CASE is pushed again.

DOWH HERT
LETTER

COMPOSER Mix name: After naming the mix, press ADD GAS
and select the gas category and the
component gas.

Press SET to save the name.

Select the digit with arrow and adjust
BACK. CHANGE the % with the UP and DOWN buttons.
CAHCEL LHSE Press set to save. Add up to 4 more
gases as needed. The total must equal
100% or an error message will appear.

GAS OPTNS allows you to adjust the
percentage of the constituents or
delete a gas from the mix. Gas mixes
cannot be adjusted after they have
been saved.

EDIT ADD GAS GAS
HAME OPTHS

COMPOSER Mix: MyGRS

@86 of Total

BACK.~ CHANGE
CAMCEL CASE

19



DOWN SELECT
DIGIT

FPercent of Air:

oH.H

BACK.~
CANCEL CLEAR

DOWN SELECT
DIGIT

Percent of He Helium:

285U

BACK.~
CANCEL CLEAR

CRERTE CREATE
NEL SIMILAR

COMPOSER USER MIX
MyGas

HRS BEEN SRVED

SELECT
MIKTURE

DOWN SELECT
DIGIT

Percent of Ar Argon:

S8.84

BACK.~
CANCEL CLERR

EDIT ADD GRS GRS
NAME OPTHS

COMPOSER Mix: MUGRS
56 Air
36 AR Argon
26 He Helium
188,863 Total

CANCEL

Once the mix has been saved, you
may press CREATE SIMILAR to
compose an additional mix based
on the mix you have just saved.
This CREATE SIMILAR option is not
available after leaving this screen.

Press CREATE NEW to add a
completely new mix.

Press SELECT MIXTURE to bring the
custom mix onto the MAIN display.

20



COMMUNICATION SELECT

Access Communication Select by pressing
the button above R$232 COMM or RS485
COMM on the Select Menu display.

LINIT ID EALD Unit ID — Valid unit identifiers are the
A letters A-Z and @. The identifier allows
you to assign a unique address to each
device so that multiple units can be
connected to a single RS-232 or RS-485
computer port.
Press UNIT ID. Use the UP and DOWN
buttons to change the Unit ID. Press SET to
record the ID. Press Reset to return to the
previously recorded Unit ID.
Any Unit ID change will take effect when
Communication Select is exited.
If the symbol @ is selected as the Unit
UNIT 1D ID, the device will enter streaming mode
> when Communication Select is exited.
See RS-232 Communications (page 25) for
|: information about the streaming mode.
Baud — Both this instrument and your
computer must send/receive data at the
BACK RESETA same baud rate. The default baud rate for
this device is 19200 baud.
Press the Select button until the arrow is
in front of Baud. Use the UP and DOWN
buttons to select the baud rate that
matches your computer. The choices are
38400, 19200, 9600, or 2400 baud.
BALD DOl Any baud rate change will not take effect

until power to the unit is cycled.
192214
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MISCELLANEOUS
Miscellaneous is accessed by pressing the MISC button on the Select Menu display.
Next select either MISC1 or MISC2.
MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband.
e PREGE FLo Zero deadband is a value below which the display
BAKD AVG RVG jumps to zero. This deadband is often desired to
prevent electrical noise from showing up on the
display as minor flows or pressures that do not
exist. Display Zero Deadband does not affect the
LCD analog or digital signal outputs.

CONTRAST MAIN

ZERO BAND can be adjusted between 0 and
3.2% of the sensor’s Full Scale (FS).
Press ZERO BAND. Then use SELECT to choose
the digit with the arrow and the UP and DOWN
buttons to change the value. Press SET to record
your value. Press CLEAR to return to zero.

DOWN- SELECT Pressure Averaging and Flow Averaging may

be useful to make it easier to read and interpret
E_E rapidly fluctuating pressures and flows. Pressure
and flow averaging can be adjusted between 1
(no averaging) and 256 (maximum averaging).

CANCEL  CLEAR These are geometric running averages where
the number between 1 and 256 can be
considered roughly equivalent to the response
time constant in milliseconds.

This can be effective at “smoothing” high frequency process oscillations such as
those caused by diaphragm pumps.

Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to
return to zero.

Press FLOW AVG. Then use SELECT to choose the
digit with the arrow and the UP and DOWN buttons
to change the value. Press SET to record your value.
Press CLEAR to return to zero.

Setting a higher number will equal a smoother
display.

LCD CONTRAST: The display contrast can be
CANCEL  RESET adjusted between 0 and 30, with zero being the
lightest and 30 being the darkest. Use the UP
and DOWN buttons to adjust the contrast. Press
SET when you are satisfied. Press CANCEL to
return to the MISC display.
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DIAG ROTATE
TEST 8]

ISP

STP STP
TEMP PRESS

MISC2 will display as shown at left.

STP refers to the functions that allow
selection of standard temperature and
pressure conditions. This feature is generally
useful for comparison purposes to other
devices or systems using different STP
parameters.

The STP menu is comprised of the STP TEMP
and STP PRESS screens.

STP TEMP allows you to select from seven
standard temperature protocols. The arrow
position will automatically default to the
currently stored value.

Once a selection has been made and recorded
using the SET button, a change acknowledgement
message will be displayed on screen.

Selecting RETURN will revert screen to the
Main display. If the SET selection is already
the currently stored value, a message
indicating that fact will appear.

STP PRESS enables you to select from one of
two standard pressure settings.

The arrow position will automatically default
to the currently stored value.

Once a selection has been made and recorded using the SET button, a change
acknowledgement message will be displayed on screen.

Selecting RETURN will revert screen to the Main display. If the SET selection is
already the currently stored value, a message indicating that fact will appear.

DOLINN
@ C

15 C

15.56 C &@F
> 2111 C TBF

25 C

ir C
STP CHANGED 21.11 C

RETURN

STP TEMP Display

P DOLIN

> latm 14.696 PSIA
1 bar 188KPa 14.568P

--- 5TP ALREARDY SET ---

RETLIRN SET

STP PRESS Display
23



SCROLL
: AP Sig

: Temp Sig

: DF Side

DF Brdg
* AP Brdg
¢ Meter Func
: Power Up

ERCK

7arl
39671
9286
I66T3
I66T3
192
I2reg

MAIH

DIAG TEST: This diagnostic screen displays
the initial register values configured by the
factory, which is useful for noting factory
settings prior to making any changes. It is
also helpful for troubleshooting with Alicat
customer service personnel.

Select the DIAG TEST button from the MISC2
screen to view a list of select register values.
Pressing the SCROLL button will cycle the

display through the register screens. An
example screen is shown at left.

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The
display and buttons will rotate together.

MANUFACTURER

MODEL
INFO

DATA

ALICAT SCIENTIFIC

Ph  S28-298-6868
Fax 5268-298-0162

MODEL:
SERIAL HO:
DATE MFG:
DATE CAL:
CAL EY:
Sl REV:

M-18E5CCH-D
1EEIEE
1872814
1892614
DL

SuEE.G

Manufacturer Data is accessed by pressing
the MFG DATA button on the Select Menu
display.

The initial display shows the name and
telephone number of the manufacturer.

Press MODEL INFO to show important
information about your flow device
including the model number, serial
number, and date of manufacture.

Press BACK to return to the MFG DATA
display.

Push MAIN to return to the Main display.
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RS-232 / RS-485 Output and Input
Configuring HyperTerminal®:

1. Open your HyperTerminal® RS-232 / RS-485 terminal program (installed under
the “Accessories” menu on all Microsoft Windows® operating systems).

2. Select “Properties” from the file menu.

3. Click on the “Configure” button under the “Connect To” tab. Be sure the
program is set for: 19,200 baud (or matches the baud rate selected in the
RS-232 / RS-485 communications menu on the meter) and an 8-N-1-None (8
Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4. Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI
or Auto Detect.

5. Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line
Feeds” box is not checked and the “Echo Typed Characters Locally” box and
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings
not mentioned here are normally okay in the default position.

6. Save the settings, close HyperTerminal® and reopen it.

Streaming Mode (RS-485 units do not have a streaming mode)

In the default Polling Mode, the screen should be blank except the blinking cursor.
In order to get the data streaming to the screen, hit the “Enter” key several times
to clear any extraneous information. Type “*@=@" followed by “Enter” (or using
the RS-232 / RS-485 communication select menu, select @ as identifier and exit
the screen). If data still does not appear, check all the connections and COM port
assignments.

Streaming Mode — Advanced

The streaming data rate is controlled by register 91. The recommended default rate
of data provision is once every 50 milliseconds and this is suitable for most purposes.

If a slower or faster streaming data rate is desired, register 91 can be changed to a
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute.

Below approximately 40 milliseconds, data provision will be dependent upon
how many parameters are selected. Fewer data parameters can be streamed
more quickly than more. It is left to the user to balance streaming speed with
number of parameters streamed.

To read register 91, type “*r91” followed by “Enter”.

To modify register 91, type “*w91=X", where X is a positive integer from 1 to
65535, followed by “Enter”.

To return to the recommended factory default streaming speed, type “*w91= 50",

Communication Set Up
http://www.alicat.com/support/instructional-videos/
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Tareing via RS-232 / RS-485:

Tare —Tareing (or zeroing) the flow meter provides it with a reference point for
zero flow. Thisis a simple but important step in obtaining accurate measurements.
Itis good practice to “zero” the flow meter each time it is powered up. A unit may
be Tared by following the instructions on page 10 or it may be Tared via RS-232
/ RS-485 input.

To send a Tare command via RS-232 / RS-485, enter the following strings:
In Polling Mode: Address$SSV<Enter> (e.g. BSSV<Enter>)
Changing From Streaming to Polling Mode:

When the meter is in the Streaming Mode (RS-485 units do not have a streaming
mode), the screen is updated approximately 10-60 times per second (depending
on the amount of data on each line) so that the user sees the data essentially in
real time. It is sometimes desirable, and necessary when using more than one
unit on a single RS-232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of data
when it is “polled”. Each unit can be given its own unique identifier or address.
Unless otherwise specified each unit is shipped with a default address of capital
A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of
information filling your screen:

1. Type *@=Afollowed by “Enter” (or using the RS-232 / RS-485 communication
select menu, select A as identifier and exit the screen) to stop the streaming
mode of information. Note that the flow of information will not stop while
you are typing and you will not be able to read what you have typed. Also,
the unit does not accept a backspace or delete in the line so it must be typed
correctly. If in doubt, simply hit enter and start again. If the unit does not
get exactly what it is expecting, it will ignore it. If the line has been typed
correctly, the data will stop.

2. You may now poll the unit by typing A followed by “Enter”. This does an
instantaneous poll of unit A and returns the values once. You may type A
“Enter” as many times as you like. Alternately you could resume streaming
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the
unit from the streaming mode.

3. To assign the unit a new address, type *@=New Address, e.g. *@=B. Care
should be taken not to assign an address to a unit if more than one unitis on
the RS-232 / RS-485 line as all of the addresses will be reassigned. Instead,
each should be individually attached to the RS-232 / RS-485 line, given an
address, and taken off. After each unit has been given a unique address, they
can all be put back on the same line and polled individually.

26



Gas Select — The selected gas can be changed via RS-232 / RS-485 input. To
change the selected gas, enter the following commands:

In Polling Mode: AddressSS#<Enter> (e.g. BSSH<Enter>)

Where # is the number of the gas selected from the table below. Note that
this also corresponds to the gas select menu on the flow controller screen (the
Standard gas category is shown in the example below):

# GAS

0 Air Air

1 Argon Ar

2 Methane CH4

3 Carbon Monoxide co

4 Carbon Dioxide co2

5 Ethane C2H6

6 Hydrogen H2

7 Helium He

8 Nitrogen N2

9 Nitrous Oxide N20

10 Neon Ne

11 Oxygen 02

12 Propane C3H8

13 normal-Butane n-C4H10

14 Acetylene C2H2

15 Ethylene C2H4

16 iso-Butane i-C2H10

17 Krypton Kr

18 Xenon Xe

19 Sulfur Hexafluoride SF6

20 75% Argon / 25% CO2 C-25

21 90% Argon / 10% CO2 C-10

22 92% Argon / 8% CO2 C-8

23 98% Argon / 2% CO2 Cc-2

24 75% CO2 / 25% Argon C-75

25 75% Argon / 25% Helium HE-75

26 75% Helium / 25% Argon HE-25
90% Helium / 7.5% Argon / 2.5% CO2

27 (Praxair - Helistar® A1025) A1025

90% Argon / 8% CO2 / 2% Oxygen
2s (Praxair - Stargon® CS) S
29 95% Argon / 5% Methane P-5

For example, to select Propane, enter: $$12<Enter>
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Creating and Deleting Gas Mixtures with COMPOSER™ using RS-232 or RS-485
Note: All commands must be prefixed with the unit ID if the unit is not in
streaming mode.

You may create and store up to 20 gas mixtures containing up to five constituent
gases each.

Create a Gas Mixture

To create a gas mixture, enter a single-line command according to the following
formula: [Unit ID]JGM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1]
[Percent 2] [Gas Number 2] ...

Gas Name: Name your mixture using a maximum of 6 characters.

Gas Mix Number: COMPOSER™ user mixes have Alicat gas numbers between
236 and 255. You can assign any number in this range to your new mixture. If
another mixture with the same number exists, it will be overwritten, even if
that gas is currently selected on the unit. If you enter a 0 here, the new mix will
be assigned the next available number between 236 and 255.

Percent 1: The percentage of the first constituent gas. The percentage of each
constituent must be between 0.01 and 99.99. Values entered beyond two
decimal points will be rounded to the nearest 0.01%.

Gas Number 1: The Alicat gas number of the first constituent gas.

Percent 2: The percentage of the first constituent gas. Values entered beyond
two decimal points will be rounded to the nearest 0.01%.

Gas Number 2: The Alicat gas number of the first constituent gas.

Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number]
may be repeated for additional constituent gases up to a total of 5 constituents.
The sum of all percentages must be 100.00.

On success, the unit ID (if set) is returned followed by a space. The number of
the gas mixture is then returned, followed by the percentages and names of each
constituent in the mix. If the gas is not successfully mixed, a "?" is returned.

Delete a Gas Mixture
To delete a gas mixture, enter:

[Unit ID]GD [Gas Number]: The number of the COMPOSER™ user mixture you
wish to delete from the unit

Only COMPOSER™ user mixtures can be deleted with this command.

On success, the unit ID (if set) is returned followed by a space and the number of
the gas deleted. If the gas is not successfully deleted, a "?" is returned.
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Collecting Data:

The RS-232 / RS-485 output updates to the screen many times per second.
Very short-term events can be captured simply by disconnecting (there are
two telephone symbol icons at the top of the HyperTerminal® screen for
disconnecting and connecting) immediately after the event in question. The scroll
bar can be driven up to the event and all of the data associated with the event
can be selected, copied, and pasted into Microsoft® Excel® or other spreadsheet
program as described below.

For longer term data, it is useful to capture the data in a text file. With the desired
data streaming to the screen, select “Capture Text” from the Transfer Menu.
Type in the path and file name you wish to use. Push the start button. When the
data collection period is complete, simply select “Capture Text” from the Transfer
Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from
a text file can be pasted directly into Excel®. When the data is pasted it will all
be in the selected column. Select “Text to Columns...” under the Data menu in
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that
“Fixed Width” is selected under Original Data Type in the first dialog box and
click “Next”. In the second dialog box, set the column widths as desired, but the
default is usually acceptable. Click on “Next” again. In the third dialog box, make
sure the column data format is set to “General”, and click “Finish”. This separates
the data into columns for manipulation and removes symbols such as the plus
signs from the numbers. Once the data is in this format, it can be graphed or
manipulated as desired.  For extended term data capture see page 30.

Data Format:

The data stream on the screen represents the flow parameters of the main mode
in the units shown on the display.

For mass flow meters, there are five columns of data representing pressure,
temperature, volumetric flow, mass flow and the selected gas.

The first column is absolute pressure (normally in psia), the second column is
temperature (normally in °C), the third column is volumetric flow rate (in the
units specified at time of order and shown on the display), and the fourth column
is mass flow (also in the units specified at time of order and shown on the
display). For instance, if the meter was ordered in units of scfm, the display on
the meter would read 2.004 scfm and the last two columns of the output below
would represent volumetric flow and mass flow in cfm and scfm respectively.

+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
Pressure Temp Vol. Flow Mass Flow Gas

M-Series Mass Flow Meter Data Format

Note: On units with the totalizer function the fifth column will be the totalizer
value, with gas select moving to a sixth column.
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Sending a Simple Script File to HyperTerminal®

Itis sometimes desirable to capture data for an extended period of time. Standard
streaming mode information is useful for short term events, however, when
capturing data for an extended period of time, the amount of data and thus the
file size can become too large very quickly. Without any special programming
skills, you can use HyperTerminal® and a text editing program such as Microsoft®
Word® to capture text at defined intervals.

1. Open your text editing program, MS Word for example.

2. Set the cap lock on so that you are typing in capital letters.

3. Beginning at the top of the page, type A<Enter> repeatedly. If you're using MS
Word, you can tell how many lines you have by the line count at the bottom of the
screen. The number of lines will correspond to the total number of times the flow

device will be polled, and thus the total number of lines of data it will produce.
For example: A

> > > >

A
will get a total of six lines of data from the flow meter, but you can
enter as many as you like.

The time between each line will be set in HyperTerminal.

4. When you have as many lines as you wish, go to the File menu and select save.
In the save dialog box, enter a path and file name as desired and in the “Save as
Type” box, select the plain text (.txt) option. It is important that it be saved as a
generic text file for HyperTerminal to work with it.

5. Click Save.

6. A file conversion box will appear. In the “End Lines With” drop down box, select
CR Only. Everything else can be left as default.

7. Click O.K.

8. You have now created a “script” file to send to HyperTerminal. Close the file
and exit the text editing program.

9. Open HyperTerminal and establish communication with your flow device as
outlined in the manual.

10. Set the flow device to Polling Mode as described in the manual. Each time you
type A<Enter>, the meter should return one line of data to the screen.

11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
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14. The “Line Delay” box is defaulted to O milliseconds. This is where you will tell
the program how often to read a line from the script file you’ve created. 1000
milliseconds is one second, so if you want a line of data every 30 seconds, you
would enter 30000 into the box. If you want a line every 5 minutes, you would
enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the
Properties dialog box.

16. Go the Transfer menu and select “Send Text File...” (NOT Send File...).
17. Browse and select the text “script” file you created.
18. Click Open.

19. The program will begin “executing” your script file, reading one line at a time
with the line delay you specified and the flow device will respond by sending one
line of data for each poll it receives, when it receives it.

You can also capture the data to another file as described in the manual under
“Collecting Data”. You will be simultaneously sending it a script file and capturing
the output to a separate file for analysis.

Operating Principle

All M-Series Gas Flow Meters (and MC Series Gas Flow Controllers) are based on the
accurate measurement of volumetric flow. The volumetric flow rate is determined
by creating a pressure drop across a unique internal restriction, known as a Laminar
Flow Element (LFE), and measuring differential pressure across it. The restriction is
designed so that the gas molecules are forced to move in parallel paths along the
entire length of the passage; hence laminar (streamline) flow is established for the
entire range of operation of the device. Unlike other flow measuring devices, in
laminar flow meters the relationship between pressure drop and flow is linear.

9 Please visit the Alicat web site for a detailed explanation this principle.
http://www.alicat.com/technical-information/theory-of-operation/

STANDARD GAS DATA TABLES: Those of you who have older Alicat products
may notice small discrepancies between the gas property tables of your old and
new units. Alicat Scientific, Inc. has incorporated the latest data sets from NIST
(including their REFPROP 9 data where available) in our products’ built-in gas
property models. Be aware that the calibrators that you may be using may be
checking against older data sets such as the widely distributed Air Liquide data.
This may generate apparent calibration discrepancies of up to 0.6% of reading on
well behaved gases and as much as 3% of reading on some gases such as propane
and butane, unless the standard was directly calibrated on the gas in question.

As the older standards are phased out, this difference in readings will cease

to be a problem. If you see a difference between the Alicat meter and your in-
house standard, in addition to calling Alicat Scientific at (520) 290-6060, call the
manufacturer of your standard for clarification as to which data set they used in
their calibration. This comparison will in all likelihood resolve the problem.
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TROUBLESHOOTING

Display does not come on or is weak.
Check power and ground connections. Please reference the technical
specifications (pages 50-64) to assure you have the proper power for your model.

Flow reading is approximately fixed either near zero or near full scale
regardless of actual line flow.

Differential pressure sensor may be damaged. Avoid installations that can
subject the sensor to excessive pressure differentials (see page 7). Acommon
cause of this problem is instantaneous application of high-pressure gas as from
a snap acting solenoid valve upstream of the meter. If you suspect that your
pressure sensor is damaged please discontinue use of the meter and contact Alicat.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and
message MOV, VOV, POV or TOV is displayed:

Our flow meters and controllers display an error message (MOV = mass
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV =
temperature overrange) when a measured parameter exceeds the range of the
sensors in the device. When any item flashes on the display, neither the flashing
parameter nor the mass flow measurement is accurate. Reducing the value of
the flashing parameter to within specified limits will return the unit to normal
operation and accuracy. If the unit does not return to normal contact Alicat.

Meter reads negative flow when there is a confirmed no flow condition.

This is an indication of an improper tare. If the meter is tared while there is flow,
that flow is accepted as zero flow. When an actual zero flow condition exists,
the meter will read a negative flow. Simply re-tare at the confirmed zero flow
condition. Also note that while the meter is intended for positive flow, it will
read negative flow with reasonable accuracy, but not to the full scale flow rate
(it is not calibrated for bi-directional flow) and no damage will result.

Meter does not agree with another meter | have in line.

Volumetric meters are affected by pressure drops. Volumetric flow meters
should not be compared to mass flow meters. Mass flow meters can be
compared against one another provided there are no leaks between the two
meters and they are set to the same standard temperature and pressure. Both
meters must also be calibrated (or set) for the gas being measured. M-Series
mass flow meters are normally set to Standard Temperature and Pressure
conditions of 25° C and 14.696 psia. Note: it is possible to special order meters
with a customer specified set of standard conditions. The calibration sheet
provided with each meter lists its standard conditions.

When performing this comparison it is best to use the smallest transition
possible between the two devices. Using small transitions will minimize lag and
dead volume.

40



Flow flutters or is jumpy.

The meters are very fast and will pick up any actual flow fluctuations such as from a
diaphragm pump, etc. Also, inspect the inside of the upstream connection for debris
such a Teflon tape shreds.

Note: M-Series meters feature a programmable geometric running average (GRA) that
can aid in allowing a rapidly fluctuating flow to be read (see “Pressure Averaging” and
“Flow Averaging” page 20).

The output signal is lower than the reading at the display.

This can occur if the output signal is measured some distance from the meter,
as voltage drops in the wires increase with distance. Using heavier gauge wires,
especially in the ground wire, can reduce this effect.

RS-232 / RS-485 Serial Communications is not responding.

Check that your meter is powered and connected properly. Be sure that the
port on the computer to which the meter is connected is active. Confirm that
the port settings are correct per the RS-232 instructions in this manual (Check
the RS-232 / RS-485 communications select screen for current meter readings).
Close Hyperterminal® and reopen it. Reboot your PC. See pages 10, 11 and 25
for more information on RS-232 / RS-485 signals and communications.

Slower response than specified.

M-Series Meters feature a programmable Geometric Running Average
(GRA). Depending on the full scale range of the meter, it may have the GRA
set to enhance the stability/readability of the display, which would result in
slower perceived response time. Please see “Pressure Averaging” and “Flow
Averaging” on page 20.

Jumps to zero at low flow.

M-Series Meters feature a programmable zero deadband. The factory setting is
usually 0.5% of full scale. This can be adjusted between NONE and 3.2% of full
scale. See page 20.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 31.
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Maintenance and Recalibration

General: M-Series Flow Meters require minimal maintenance. They have no
moving parts. The single most important thing that affects the life and accuracy
of these devices is the quality of the gas being measured. The meter is designed
to measure CLEAN, DRY, NON-CORROSIVE gases.

Moisture, oil and other contaminants can affect the laminar flow elements.
We recommend the use of in-line sintered filters to prevent large particulates
from entering the measurement head of the instrument. Suggested maximum
particulate sizes are as follows:

5 microns for units with FS flow ranges of 0-1 sccm or less.

20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.

50 microns for units with FS flow ranges of 0-1 slpm or more.

Recalibration: The recommended period for recalibration is once every year.

A label located on the back of the meter lists the most recent calibration date.
The meter should be returned to the factory for recalibration within one year
from the listed date. Before calling to schedule a recalibration, please note the
serial number on the back of the meter. The Serial Number, Model Number, and
Date of Manufacture are also available on the Model Info display (page 24).

Cleaning: M-Series Flow Meters require no periodic cleaning. If necessary, the
outside of the meter can be cleaned with a soft dry cloth. Avoid excess moisture
or solvents.

For repair, recalibration or recycling of this product contact:

Alicat Scientific, Inc.
7641 N Business Park Drive
Tucson, Arizona 85743
USA
Phone: 520-290-6060
Fax: 520-290-0109
e-mail: info@alicat.com
Web site: www.alicat.com
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Option: Totalizing Mode
Meters can be purchased with the Totalizing Mode option. This option adds an
additional mode screen that displays the total flow (normally in the units of the
main flow screen) that has passed through the device since the last time the
totalizer was cleared.
The Totalizing Mode screen is accessed by
pushing the TOTAL button on the MAIN display.

— G TOTAL/TIMER:  Pushing the TOTAL/TIMER

TIMER

b.g button will cycle the large numbers on the

IEiEiEIIEIEI.EElCE

display between total mass and time elapsed.

Rollover — The customer can also specify at the
M

ABRE:EE:60 time of order what the totalizer is to do when
the maximum count is reached. The following
BACK  RESET MEHNU options may be specified:

No Rollover — When the counter reaches the
maximum count it stops counting until the
counter is cleared.

Rollover — When the counter reaches the maximum count it automatically rolls
over to zero and continues counting until the counter is cleared.

Rollover with Notification — When the counter reaches the maximum count
it automatically rolls over to zero, displays an overflow error, and continues
counting until the counter is cleared.

TOTAL MASS: The counter can have as many as seven digits. At the time of order,
the customer must specify the range. This directly affects the maximum count. For
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in
liters, the maximum count would be 99999.99 liters. If the same unit were specified
with a 1 liter range, the maximum count would be 9999999 liters.

ELAPSED TIME: The small numbers below the mass total show the elapsed time
since the last reset in hours, minutes and seconds. The maximum measurable
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when
RESET is pushed, an RS-232 or RS-485 clear is executed or on loss of power. Press
ELAPSED TIME to show this as the primary display.

RESET — The counter can be reset to zero at any time by pushing the RESET
button. To clear the counter via RS-232 or RS-485, establish serial communication
with the meter or controller as described in the RS-232 or RS-485 section of the
manual. To reset the counter, enter the following commands:

In Polling (addressable) Mode: AddressSST <Enter> (e.g. BSST <Enter>)
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Alicat Portable Meters and Gauges

Alicat Rechargeable Flow Meters and Pressure Gauges use a Li-lon 3.7V cell located in the top
section of the device. The Li-lon cell must not be removed.

Normal battery life of a fully-charged cell is 18 hours with a monochrome display or
5 hours with a TFT color display, when the backlight is set to 10. Dimming the backlight
will increase battery life.

The battery can be charged through either the micro-USB port or the mini-DIN connector.
When the device is connected to external power it will function normally while the battery
is charging. Note: |f the battery has no charge, a charge time of one minute will be required
before the unit can be turned on. Charge rates will be fastest through the micro-USB port
using the included power supply or equivalent. The device will charge fastest when it is
turned off.

Recharge Time: 3.5 hours with 2A USB supply. The micro-USB port is for charging purposes only.

The green/red indicator LED on top of the device will light up green to indicate that the
unit is charging. The green LED will turn off when the battery is charged and the power
switch is turned to “I” for ON.

The indicator LED flashes red when the device has about 1 hour of battery life remaining. The
LED will flash red at a faster rate when the device has about 15 minutes of battery life remaining.
Itis highly recommended that the device be charged immediately. When the battery charge runs
out with a color display, the display will shut off and device performance is no longer guaranteed.
When the battery charge runs out on a monochrome display, the display contrast will turn to 0
and device performance is no longer guaranteed.

Output signals from the meter are passed through the mini-DIN connector on top
of the device. Rechargeable battery units do not support 0-10V analog output.
Receiver resistance must be below 250Q.

Turn the power switch on top of the device to “O” for OFF when it is not in use.

Warning: If the device is left ON until the battery can no longer power it, the
charge indicator will fall out of sync with the actual charge. The device can be
re-synced by fully charging the battery once.

A Battery Charge Indicator appears below Tare on the display:

TOP VIEW OF DEVICE

- 10/

95 - 100% Green = Charging

+1§_55I§ +2°1.C59 TARE V 80 —95% Flashing Red = Low Battery
50 -80% +5 Vdc On / Off

Charge Only /0
20-50% | |
0,008 +0.000 5-20% ¢
1 SCCH  MENU

0-5% o

CAUTION! Do NOT OPERATE OR STORE THE DEVICE OUTSIDE OF THE -10°

TO +50°C TEMPERATURE RANGE. IF INTERNAL SENSORS DETECT THAT THE
TEMPERATURE IS OUTSIDE OF THIS RANGE, THE DISPLAY CONTRAST WILL TURN TO 0
AND THE METER’S PERFORMANCE IS NO LONGER GUARANTEED.

THE SAFE CHARGING TEMPERATURE RANGE IS 0° TO +45°C. IF INTERNAL SENSORS DETECT
TEMPERATURES OUTSIDE OF THIS RANGE, THE BATTERY WILL NOT CHARGE.
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Option: Remote Electronics for High Line or Gas Temperatures

Some applications involve operating
temperatures outside the standard Alicat
device specifications. A solution using
remote electronics is available. (This option is
not applicable for liquid devices.)

The flow body’s components are minimized
to only the required sensors. The flow data is
sent to the microprocessor electronics up to
6 feet away from the sensor package.

Relocating the sensitive electronics allows
for installation of the flow body in ambient
temperatures as high as 85° Celsius with gas temperatures under 100°Celsius.

In these applications we recommend our custom gauge calibration at a

gas temperature of up to 70°Celsius. This will reduce zero shift errors that
occur when actual gas flow temperatures deviate substantially from the gas
calibration temperature.

This configuration is also used in integrations that require a compact flow
package at the installation point.

Option: Remote Panel Display

Our Remote Display option offers the flexibility of using
Alicat’s display with units that are embedded inside
processes or instrument enclosures.

The Remote Display retains all of the same features as our
standard display.

The Remote Display is ideal for:
o OEMs Remote Panel Mounting « Embedded Systems
o Gas Panels « Fuel Cell Test Stations

o Leak Detection Systems « Artificial Environments
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Accessory: BB9 Multi-Drop Box

The BB9 Multi-Drop Box makes it convenient to wire
multiple flow and/or pressure devices to a single RS-232 or
RS-485 port. Now available with a USB interface!

The Multi-Drop Box has nine 8 pin mini-DIN ports available.
The ports are to be used with a standard double ended 8 pin
mini-DIN (DC-62) style cable going from the box to each flow
or pressure device.

A single DB9 D-SUB type connector (COM PORT) connects, using the included
cable, to the serial connector on a PC or laptop.

All of the flow and/or pressure devices are powered via a terminal block on the
front of the box.

If more than nine devices will be required, additional Multi-Drop Boxes can be
daisy chained together with a double ended 8 pin mini-DIN cable plugged into
any receptacle on both boxes.

BB9 Power Supply for Large Valve Controllers: The PS24VHC (Power Supply
24Vdc High Current) is a 6.5Amp 24Vdc power supply designed for running
multiple large controllers on a BB9.

The 6.5Amp power supply can run as many as 8 large valve controllers, which
makes it ideal for the BB9 and multiple large valve (or small valve / large valve
combination) controllers on a BB9.

BB9 Multi-Drop Box

— 1.55 —
@ .156 Thru 4 Places 6.75
1.75
3.46 L 5.06
@ .340 Thru 2 PL |
7.56 @ .175Thru 2 PL
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Accessory: Flow Vision™ SC Software

Flow Vision™ SC is an intuitive software interface to help your test
cycles run smoother and shorten your engineering time!

Flow Vision™ SC lets you connect to and communicate with multiple Alicat
units simultaneously. Now you can view virtual displays, control tabs, charts
and data lines from every connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial communication
functions, including: gas selection, tareing, set-point control, valve tuning
and flow averaging.

Session Saving: Save and reload your configuration data with confidence.

Script Building: Create scripts to adjust a controller’s set-point value at
variable specified time intervals.

Charting: Chart as many parameters as you want off as many devices as you
want, with color coding, zooming, and printing functionality.

Alarms: Create software alarms that will notify you of given parameter conditions.

Data Capture & Logging: Capture and log data to either a .csv file or a .txt file.
Improved Data Logging and Data Log File Splitting for easy to manage data.

Accessory: Flow Vision™ MX Software
Alicat’s New Flow Vision™ MX software gives you an easy way to do
GAS BLENDING using Alicat Mass Flow Controllers and your own PC.
Flow Vision™ MX software is a simple way to connect up to six Alicat
mass flow controllers and create your own gas mix concentrations.

Using our inexpensive BB9-USB and a single USB connection you can:

e (Create your own gas blends
e Adjust flow rates
e  Save your specific blend formulas.

All the controllers can be powered through the BB9-USB with a single
power supply.

Just connect your unique gases to each controller, select the gas type either
locally on the controller or through Flow Vision™ MX, manifold the flow
outputs and create your gas mix.
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Accessories

Part Number

Description

FLOWVISIONSC | Flow Vision™ SC software for interface with all Alicat instruments
FLOWVISIONMX | Flow Vision™ MX software for gas blending

BB9 9 position Multi-Drop Box

BB9-I 9 position Multi-Drop Box, Industrial connectors

PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter
PS24VHC High current power supply for BB9 use with Large Valve Controllers
PCASE Industrial carry and storage case for portable meters/gauges

DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length
DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length
DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length
DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length
DC-751 8 Pin Male Mini-DIN connector cable, single ended, 75 foot length
DC-6RT 8 Pin Male Right Angle Mini-Din Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length
DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length
MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length
DBC-251 DB15 cable, single ended, 25 foot length

510199 DB9 cable, double-ended female, 3 meter length

IC10 Industrial cable, 6 Pin, single ended, 10 foot length

IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length

1C20 Industrial cable, 6 Pin, single ended, 20 foot length

1C24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length

IC50 Industrial cable, 6 Pin, single ended, 50 foot length

1C-102 Industrial cable, 6 pin double ended, 10 foot length

USB-RS232 RS-232 to USB Converter
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Accessories

MNPT to Compression Fittings

Filters & Elements FNPT-MNPT

10-32-1/8” | $5-200-1-0157 10-32 5 510053
10-32-1/4” | $S-400-1-0256 10-32 20p 510054
1/8”-1/8" $5-200-1-2 1/8” 204 ILF-1/8-20
1/8"-1/4" $5-400-1-2 1/4” 40p ILF-1/4-40
1/8”-3/8” $5-600-1-2 1/2” 40 ILF-1/2-40*
1/8" - 1/2" $5-810-1-2 3/4” 40p ILF-3/4-40*
1/8” - 3mm SS-3M0-1-2 20u element ILFE20
1/8” - 4mm $5-4M0-1-2 40y element ILFE40
1/8” - 6mm $5-6MO0-1-2 40u element ILFE40L*
1/8” - 8mm $5-8M0-1-2
1/8” - 12mm SS-12M0-1-2 Filters & Elements FNPT-FNPT*
1/4” - 1/8" $5-200-1-4 10-32 54 CF-303-20-316
1/4” - 1/4” SS-400-1-4 *requires MNPT to MNPT coupler to
1/4” -3/8” SS-600-1-4 interface with Alicat flow bodies
1/4” -1/2" $5-810-1-4
1/4” - 3mm 5$S-3M0-1-4 10-32 Male UNF to 1/8 FNPT Adapter
1/4” - 4mm S5-4MO-1-4 410133
1/4” - 6mm >5-6MO-1-4 Male M5 (10-32) Buna-N O-ring face seal
1/4” - 8mm SS-8M0-1-4 to 1/8”Female NPT
1/4”-12mm | S5-12M0-1-4
1/2” -1/8" $5-200-1-8
1/2” -1/4” $5-400-1-8
1/2” - 3/8” $5-600-1-8
1/2”-1/2" $5-810-1-8
1/2” -3/4” $5-1210-1-8
1/2” - 6mm $5-6M0-1-8
1/2” - 8mm $5-8M0-1-8
1/2”-12mm | S5-12M0-1-8
1/2”-16mm | S5-16M0-1-8
3/4” - 1/4” $5-400-1-12
3/4”-1/2" $5-810-1-12
3/4” -3/4” $5-1210-1-12
3/4” -12mm | $5-12M0-1-12
3/4”-16mm | SS-16M0-1-12
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Technical Data for Alicat M Mass Flow Meters
0 to 0.5 sccm Full Scale through 0 to 4000 slpm Full Scale

Standard Operating Specifications (Contact Alicat for available options)

Performance M-Series Mass Flow Meter

Accuracy at calibration conditions +(0.8% of Reading + 0.2% of Full Scale)

after tare
High Accuracy at calibration conditions + (0.4% of Reading + 0.2% of Full Scale)
after tare High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Accuracy for Bidirectional Meters
at calibration conditions after tare

Repeatability
Zero Shift and Span Shift
Operating Range / Turndown Ratio

+ (0.8% of reading + 0.2% of total span from positive full scale to negative full scale)

+0.2% Full Scale
0.02% Full Scale / °Celsius / Atm
0.5% to 100% Full Scale / 200:1 Turndown
128% Full Scale
10 ms (Adjustable)
<1 Second

Maximum Measurable Flow Rate

Typical Response Time
Warm-up Time

Operating Conditions M-Series Mass Flow Meter
Mass Reference Conditions (STP)

Operating Temperature

25°C & 14.696 psia (standard — others available on request)
-10 to +50 °Celsius

Humidity Range (Non—-Condensing) 0 to 100%
Maximum Internal Pressure (Static) 145 psig
Maximum Allowable Instantaneous Differential 75 psid
| Pressure Across Device (Inlet to Outlet) P
Proof Pressure 175 psig
Mounting Attitude Sensitivity None
Ingress Protection IP40

303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Rein-
forced Nylon, Aluminum. If your application demands a different material,
please contact Alicat.

Wetted Materials

Communications / Power
Monochrome LCD or Color TFT
Display with integrated touchpad
Digital Output Signal' Options

M-Series Mass Flow Meter
Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

RS-232 Serial / RS-485 Serial / Modbus / PROFIBUS®
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA

Analog Output Signal? Options
Optional Secondary Analog Output

0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA

Signal?
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking
Supply Voltage 7 to 30 Vdc (15-30 Vdc for 4-20 mA outputs)

Supply Current 0.040 Amp (+ output current on 4-20 mA)
1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass
Flow, Volumetric Flow, Pressure or Temperature
3. If selecting PROFIBUS, no analog signal is available. See PROFIBUS specifications for supply voltages and
currents (www.alicat.com/profibus). PROFIBUS and Modbus units do not have the display.

Range Specific Specifications

Full Scale Flow Mass Pressure Drop at FS Flow Mechanical orec?
Meter (psid) venting to atmosphere Dimensions Process Connections
0.5 sccm to 1 sccm 1.0 5
2 scem to 50 scem 1.0 3.9Hx24'Wx 1.1"D | M-5(10-32) Female Thread
100 sccm to 20 slpm 1.0 4.1"H x2.4"W x 1.1"D 1/8” NPT Female
50 slpm 2.0 0 o . "
100 slpm 25 4.4Hx4.0'W x 1.6"D 1/4” NPT Female
250 slpm 2.1 5.0"Hx4.0'W x 1.6"’D 1/2" NPT Female
500 slpm 4.0 3/4” NPT Female
1000 slpm 6.0 5.0'Hx4.0'W x 1.6"D | (A1-1/4” NPT Female optional
1500 slpm 9.0 process connection is available
2000 slpm 5.0 5.3'Hx 5.2"W x 2.9'D for 2000 slpm meters.)
3000 slpm 71 5.3"H x 5.2"W x 2.9'D 1-1/4” NPT Female
4000 slpm 4.4 7.6"Hx5.2"W x 2.9'D 2" NPT Female

SAE connections upon request.

1. Lower Pressure Drops Available, please see our WHISPER-Series mass flow controllers at www.alicat.com/whisper.
2. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and

3. Shipped with M-5 (10-32) Male Buna-N O-ring face seal to 1/8” Female NPT fittings.
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Technical Data for WHISPER Low Pressure Drop Mass Flow Meters
0 to 0.5 sccm Full Scale through 0 to 500 slpm Full Scale
Standard Operating Specifications (Contact Alicat for available options.)

Performance Whisper Mass Flow Meter
Accuracy at calibration conditions + (0.8% of Reading + 0.2% of Full Scale)
after tare
High Accuracy at calibration conditions + (0.4% of Reading + 0.2% of Full Scale)
after tare High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Accuracy for Bidirectional Meters

o " o - .
at calibration conditions after tare + (0.8% of reading + 0.2% of total span from positive full scale to negative full scale)

Repeatability +0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / °Celsius / Atm
Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Maximum Measurable Flow Rate 128% Full Scale
Typical Response Time 10 ms (Adjustable)
Warm-up Time <1 Second
Mass Reference Conditions (STP) 25°C & 14.696 psia (standard — others available on request)
Operating Temperature -10 to +50 °Celsius
Humidity Range (Non—-Condensing) 0 to 100%
Maximum Pressure 45 psig
Maximum Allowable Instante}neous Differential 15 psid
Pressure Across Device (Inlet to Outlet)
Proof Pressure 175 psig
Mounting Attitude Sensitivity None
Ingress Protection P40

303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass
Wetted Materials Reinforced Nylon, Aluminum
If your application demands a different material, please contact Alicat.

Communications / Power Whisper Mass Flow Meter
Monochrome LCD or Color TFT
Display with integrated touchpad

Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Output Signal' Options RS-232 Serial / RS-485 Serial / Modbus / PROFIBUS3
Analog Output Signal? Options 0-5Vdc/1-5Vdc/0-10 Vdc / 4-20 mA
Optional Secondary Analog Output
. 2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA
Signal
Electrical Connection Options 8 Pin Mini-DIN / 9-pin D-sub (DB9) / 15-pin D-sub (DB15) / 6 pin locking
Supply Voltage 7 to 30 Vdc (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp (+ output current on 4-20 mA)

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature

2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass
Flow, Volumetric Flow, Pressure or Temperature

3. If selecting PROFIBUS, no analog signal is available. See PROFIBUS specifications for supply voltages and
currents (www.alicat.com/profibus). PROFIBUS and Modbus units do not have the display.

Range Specific Specifications

Full Scale Flow Pressure Drop at FS Flow

. . . el
Mass Meter (psid)venting to atmosphere Mechanical Dimensions Process Connections
0.5 scem to 2 scem 0.06 . . ) M-5 (10-32) Female Thread?
5 sccm to 20 sccm 0.07 ATHRAGW S LT
50 sccm 0.07
100 sccm to 200 sccm 0.06 » ” » »
500 scom 007 41"Hx2.4"W x 1.1"D 1/8” NPT Female
1 slpm to 5 slpm 0.07
10 slpm 0.08 4.3'Hx2.7"W x 1.1"D "
20 slpm 0.25 44Hx4.0Wx 1.6'D Iy WP (RamElE
40 slpm 0.12 5.0'"H x 4.0"W x 1.6"D 1/2" NPT Female
50 slpm 0.14
100 slpm 0.24 5.0’"H x 4.0"W x 1.6"D 3/4” NPT Female
250 slpm 0.60
500 slpm 0.39 5.3'Hx 5.2"W x 2.9'D 3/4” NPT Female

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and
SAE connections upon request.
2. Shipped with M-5 (10-32) Male Buna-N O-ring face seal to 1/8” Female NPT fittings.
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Technical Data for Alicat MS-Series Mass Flow Meters

Alicat MS instruments are built for use with aggressive gases. For the most part, these
instruments maintain the specifications of equivalently ranged M-Series devices.

Standard Compatible Gas List for MS-Series Meters

0 Air Air 23 | 98% Ar / 2% CO2 C-2
1 Argon Ar 24 | 75% CO2 [ 25% Ar C-75
2 Methane CH4 25 | 75% Ar / 25% He HE-75
3 | Carbon Monoxide Cco 26 | 75% He [/ 25% Ar HE-25
4 Carbon Dioxide Cc02 90% He / 7.5% Ar /

5 Ethane C2H6 27 2.5% CO2 A1025
6 Hydrogen H2 Helistar® A1025

7 Helium He 90% Ar / 8% CO2 /

8 Nitrogen N2 28 2% 02 Star29
9 Nitrous Oxide N20 Stargon® CS

10 Neon Ne 29 | 95% Ar /5% CH4 P-5
11 Oxygen 02 30 Nitric Oxide NO
12 Propane C3H8 31 | Nitrogen Triflouride NF3
13 normal-Butane n-C4H10 32 Ammonia NH3
14 Acetylene C2H2 33 Chlorine Gas Ci2
15 Ethylene C2H4 34 | Hydrogen Sulfide H2S
16 iso-Butane i-C4H10 35 Sulfur Dioxide SO2
17 Krypton Kr 36 Propylene C3H6
18 Xenon Xe In addition, the following gases are
19 | Sulfur Hexafluoride SF6 available upon request:

20 | 75%Ar / 25% CO2 C-25 Nitrogen Dioxide to 0.5% NO2
21 | 90% Ar / 10% CO2 c-10 in an inert carrier

22 | 92% Ar / 8% CO2 C-8 Refrigerant gases to 100%

If your application requires another gas or gas mixture, please contact
Info@alicat.com or call 888-290-6060. We will do our best to accommodate
your request.

Please refer to the Technical Data for the equivalently ranged M-Series
instrument for all operating specifications except:

Operating Range 1% to 100% Full Scale

Turndown Ratio 100:1

316LSS, FFKM (Kalrez) standard; Viton, EPDM, Buna,

Wetted Materials
Neoprene as needed for some gases.

The dimensions of MS instruments may vary from their standard M-Series
counterparts. Dimensional drawings for MS instruments are shown on pages 52-55.
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4000 slpm approximate shipping weight: 12.2 Ib
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Technical Data for PROFIBUS Meters, Gauges and Controllers
NOTICE: The following specifications are applicable to Alicat PROFIBUS enabled meters,
gauges and controllers only.

All other operating specifications are shown in the Technical Data page for standard Alicat
instruments.

All standard device features and functions are available and operate in accordance with the
standard Alicat Scientific device operating manual provided with the device.

Specification Meter or Small Valve Large Valve Description
P Gauge Controller Controller P
Input /Output Signal Digital PROFIBUS DP
Electrical Connections DB9
Supply Voltage: 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
80mA @ 12Vdc | 295mA @ 12Vdc
Supply Current 65mA @ 24Vdc | 280mA @ 24Vdc 780mA @ 24Vdc
Power and Signal Connections: TOP SIDE
Connect to the device using two DB9 5(0 0000 15
connectors. 2\ 0000 /s 6 9
. 1.NC 1.NC
The female top connection is PROFIBUS. 2. OPT GND 2 RS232RX
The male connection on the side is power and i- g?s i~ 52232“
RS-232 or RS-485. 5 DGD 5 GND
Pin out diagrams for all PROFIBUS enabled g- ‘(’J';T” 30VDC g- ;IC S0VDC
Alicat devices are shown: eon A
9.NC 9.NC

O

ZZALCAT

il
B Corpable
[
—.

.26

1/8 NPT 35
Both Sides ~—__ J ’ |
3.59 —
525 — 376
1.056 ———-

[—2.225
150 ——

~ 2x8-32UNC ¥ .350
/25
/

s

@ o 00?

T T
.?25

MC-1SLPM-PROFIBUS

PROFIBUS MC1SLPM shown to provide PROFIBUS connector dimensions only. Flow
body and valve dimensions will vary with range. Please see Alicat’s device specifications for

complete dimensions.

PROFIBUS units do not have a display screen.
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Eight Pin Mini-DIN Connector Pin-Outs

If your Alicat Instrument was ordered with the standard Eight Pin Mini-DIN
connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out

Pin | Function Mini-DIN
cable color
1 [Inactive (or optional 4-20mA Primary Output Signal) Black
) Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, Brown

5Vdc, 10Vdc) or Basic Alarm]

3 | Serial RS-232RX / RS-485(—) Input Signal (receive) Red

Meters/Gauges = Remote Tare (Ground to Tare)

4 Controllers = Analog Set-Point Input Orange
5 |Serial RS-232TX / RS-485(+) Output Signal (send) Yellow
6 | 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 | Power In (as described above) Blue

3 Ground (common for power, digital communications, analog signals Purple

and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers with the
Mini-DIN connector. The availability of different output signals depends on the options
ordered. Optional configurations are noted on the unit’s calibration sheet.
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Locking Industrial Connector Pin-Outs

If your Alicat Instrument was ordered with a Six Pin Locking Industrial
connection, please be sure to reference the following pin-out diagram.

Male Connector: Cable Female Connector: Device

Pin | Function

Power In (+)

RS-232TX / RS-485(+)

RS-232RX / RS-485(-)

Meters/Gauges = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input

5 |Ground (common for power, communications and signals)
6 |Signal Out (Voltage or Current as ordered)

BIW[IN|=

The above pin-out is applicable to all the flow meters and controllers ordered with the
9 industrial connector. The availability of different output signals depends on the flow
meter options ordered.

The locking industrial connector is standard on all CSA/ATEX approved devices.
9 RS-485 is not available on CSA/ATEX approved devices.
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9 If your instrument was ordered with a DB9 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

Standard DB9 Pin-out
The following pin-out chart describes the safest and generally compatible
arrangement when connecting a non-Alicat DB9 wire to a DB9 equipped Alicat.
Not all features may be available between brands, but the common denominators
are featured in our DB9 offerings, along with some options for customization.

Male Connector Front View Female Connector Front View
Pin |Function
1 Not Connected (4-20mA analog output signal optional)
) 5.12 Vdc or (secondary analog output (4-20mA, 5Vdc, 10Vdc or
alarm optional)
3 Serial RS-232RX or RS-485(-)
4 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground
for remote tare function on non-controllers)
5 Serial RS-232TX or RS-485(+)
6 0-5 Vdc Output Signal (or 0-10 Vdc optional)
7 Power In (+Vdc)
3 Ground (common for power, digital communications, analog
signals and alarms)
9 Ground (common for power, digital communications, analog
signals and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers
with the DB9 connector. The availability of different output signals depends
on the options ordered. Optional configurations are noted on the unit’s
calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will
occur! Check part number or contact factory to verify RS-485
functionality.
9 Due to variance in cable manufacturing, please identify proper
wiring/pins via continuity check & color when using blunt cut
multi-strand cables.
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9 If your instrument was ordered with a DB9 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

DB9A Pin-out
The following pin-out chart describes the safest and generally compatible
arrangement when connecting a non-Alicat DB9 wire to a DB9A equipped Alicat.
Not all features may be available between brands, but the common denominators
are featured in our DBIN offerings, along with some options for customization.

Male Connector Front View Female Connector Front View

Pin |Function

1 Not Connected

2 0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Power In (+Vdc)
4

Ground (common for power, digital communications, analog
signals and alarms)

Serial RS-232TX or RS-485 (+)

Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground

6 for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog
signals and alarms)

3 Ground (common for power, digital communications, analog

signals and alarms)

9 Serial RS-232RX or RS-485 (-)
Note: The above pin-out is applicable to all the flow meters and controllers
with the DB9A connector. The availability of different output signals
depends on the options ordered. Optional configurations are noted on the
unit’s calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will
occur! Check part number or contact factory to verify RS-485
functionality.
9 Due to variance in cable manufacturing, please identify proper
wiring/pins via continuity check & color when using blunt cut
multi-strand cables.
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9 If your instrument was ordered with a DB9 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

DB9N Pin-out
The following pin-out chart describes the safest and generally compatible
arrangement when connecting a non-Alicat DB9 wire to a DBIN equipped Alicat.
Not all features may be available between brands, but the common denominators
are featured in our DBIN offerings, along with some options for customization.

Male Connector Front View Female Connector Front View
Pin |Function
1 Power In (+Vdc)
) Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground
for remote tare function on non-controllers)
3 0-5 Vdc Output Signal (or 0-10 Vdc optional)
4 Not Connected
5 Ground (common for power, digital communications, analog
signals and alarms)
6 Ground (common for power, digital communications, analog
signals and alarms)
7 Serial RS-232RX or RS-485 (-)
8 Serial RS-232TX or RS-485 (+)
9 Not Connected

Note: The above pin-out is applicable to all the flow meters and controllers
with the DBIN connector. The availability of different output signals
depends on the options ordered. Optional configurations are noted on the
unit’s calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will
occur! Check part number or contact factory to verify RS-485
functionality.
9 Due to variance in cable manufacturing, please identify proper
wiring/pins via continuity check & color when using blunt cut
multi-strand cables.
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9 If your instrument was ordered with a DB9 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

DB9R Pin-out
The following pin-out chart describes the safest and generally compatible
arrangement when connecting a non-Alicat DB9 wire to a DBIR equipped Alicat.
Not all features may be available between brands, but the common denominators
are featured in our DBIR offerings, along with some options for customization.

Male Connector Front View Female Connector Front View
Pin |Function
1 Serial RS-232TX or RS-485 (+)
0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground
for remote tare function on non-controllers)
4 Ground (common for power, digital communications, analog
signals and alarms)
5 Not Connected
6 Serial RS-232RX or RS-485 (-)
7 Power In (+Vdc)
3 Ground (common for power, digital communications, analog
signals and alarms)
9 Ground (common for power, digital communications, analog
signals and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers
with the DB9R connector. The availability of different output signals
depends on the options ordered. Optional configurations are noted on the
unit’s calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will
occur! Check part number or contact factory to verify RS-485
functionality.
9 Due to variance in cable manufacturing, please identify proper
wiring/pins via continuity check & color when using blunt cut
multi-strand cables.
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9 If your instrument was ordered with a DB9 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

DBIT Pin-out
The following pin-out chart describes the safest and generally compatible
arrangement when connecting a non-Alicat DB9 wire to a DBIT equipped Alicat.
Not all features may be available between brands, but the common denominators
are featured in our DBIT offerings, along with some options for customization.

Male Connector Front View Female Connector Front View

Pin |Function

1 Serial RS-232TX or RS-485 (+)

2 0-5 Vdc Output Signal (or 0-10 Vdc optional)
3 Power In (+Vdc)
4

Ground (common for power, digital communications, analog
signals and alarms)

Not Connected

Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground

6 for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog
signals and alarms)

3 Ground (common for power, digital communications, analog

signals and alarms)

9 Serial RS-232RX or RS-485 (-)
Note: The above pin-out is applicable to all the flow meters and controllers
with the DB9T connector. The availability of different output signals
depends on the options ordered. Optional configurations are noted on the
unit’s calibration sheet.

Do not connect RS-485 to RS-232 units or cables. Damage will
occur! Check part number or contact factory to verify RS-485
functionality.
9 Due to variance in cable manufacturing, please identify proper
wiring/pins via continuity check & color when using blunt cut
multi-strand cables.
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If your instrument was ordered with a DB9 connection, be sure to check the

Calibration Label on the device and reference the appropriate pin-out diagram.

DB9U Pin-out

The following pin-out chart describes the safest and generally compatible
arrangement when connecting a non-Alicat DB9 wire to a DB9U equipped Alicat.

Not all features may be available between brands, but the common denominators

are featured in our DB9U offerings, along with some options for customization.

Male Connector Front View Female Connector Front View
Pin |Function

1 Serial RS-232RX or RS-485(-)

2 0-5 Vdc Output Signal (or 0-10 Vdc optional)

3 Power In (+Vdc)

4 Ground (common for power, digital communications, analog

signals and alarms)

Not Connected

Analog Input Signal [4-20mA, 5Vdc, or 10Vdc] (short to ground

6 for remote tare function on non-controllers)

7 Ground (common for power, digital communications, analog
signals and alarms)

3 Ground (common for power, digital communications, analog
signals and alarms)

9 Serial RS-232TX or RS-485(+)

Note: The above pin-out is applicable to all the flow meters and controllers
with the DB9U connector. The availability of different output signals
depends on the options ordered. Optional configurations are noted on the
unit’s calibration sheet.

>

Do not connect RS-485 to RS-232 units or cables. Damage will
occur! Check part number or contact factory to verify RS-485
functionality.

Due to variance in cable manufacturing, please identify proper
wiring/pins via continuity check & color when using blunt cut
multi-strand cables.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement
when connecting a non-Alicat DB15 wire to a DB15 equipped Alicat. Not all features may be
available between brands, but the common denominators are featured in our DB15 offerings,
along with some options for customization.

DB15 — Pin-Out Alicat Style

O00O0O00C0O0
O 000QO0Q

Male Connector Front View Female Connector Front View
Pin Number Function

1 Ground

2 Primary Analog Signal Output

3 Ground

4 N/C

5 Power Supply (+Vdc)

6 N/C

7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common

10 Ground

11 Secondary Analog Signal Output / fixed 5.12Vdc

12 N/C

13 RS-232 RX (receive) or RS-485 —

14 Ground

15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 3, 9, 10 and 14 are connected together inside of the device and are
common grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-Alicat DB15 wire to a DB15A equipped Alicat. Not all features may be
available between brands, but the common denominators are featured in our DB15 offerings,
along with some options for customization.

DB15A - Pin-Out “Aalborg XFM” Style

Male Connector Front View Female Connector Front View
Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*
4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS-232 Tx (send) / RS-485, A (-) [receive]
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fixed 5.12Vdc*
13 N/C
14 N/C
15 RS-232 Rx (receive) / RS-485, A (+) [send]

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

* Added to allow for full use of features on Alicat devices, may not be present on host wiring

NOTE: Pins 1, 4, 5, 6 and 9 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-Alicat DB15 wire to a DB15B equipped Alicat. Not all features may be
available between brands, but the common denominators are featured in our DB15 offerings,
along with some options for customization.

DB15B — Pin-Out “Brooks” Style

Male Connector Front View Female Connector Front View
Pin Number Function

1 Ground

2 Primary Analog Signal Output

3 N/C

4 N/C

5 Power Supply (+Vdc)

6 N/C

7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common

10 Ground

11 Secondary Analog Signal Output / fixed 5.12Vdc

12 N/C

13 N/C

14 RS-232 RX (receive) or RS-485 —

15 RS-232 TX (send) or RS-485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 9,and 10 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-Alicat DB15 wire to a DB15K equipped Alicat. Not all features may be
available between brands, but the common denominators are featured in our DB15 offerings,
along with some options for customization.

DB15K - Pin-Out “MKS” Style

SR

o ®w

Male Connector Front View Female Connector Front View

Pin Number Function

1 N/C

2 Primary Analog Signal Output

3 N/C

4 N/C

5 Power Supply Common

6 N/C

7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)

Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fixed 5.12Vdc *

10 N/C

11 Ground

12 Ground

13 RS-232 RX (receive) or RS-485 — *

14 RS-232 TX (send) or RS-485 + *

15 Ground
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-Alicat DB15 wire to a DB15H equipped Alicat. Not all features may be
available between brands, but the common denominators are featured in our DB15 offerings,
along with some options for customization.

DB15H - Pin-Out “Hastings H” Style

Male Connector Front View Female Connector Front View
Pin Number Function

1 N/C

2 RS-232 RX (receive) or RS-485 — *

3 N/C

4 N/C

5 Ground

6 Primary Analog Signal Output

7 Power Supply Common

8 N/C

9 N/C

10 Secondary Analog Signal Output / fixed 5.12Vdc *

11 Power Supply (+Vdc)

12 Ground

13 N/C

14 Analog Tare (met_ers — when grounded)
Analog Set-Point Input (controllers)

15 RS-232 TX (send) or RS-485 + *

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 5, 7 and 12 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-Alicat DB15 wire to a DB15S equipped Alicat. Not all features may be
available between brands, but the common denominators are featured in our DB15 offerings,
along with some options for customization.

DB15S - Pin-Out “Sierra” Style

E

Male Connector Front View Female Connector Front View
Pin Number Function

1 Ground

2 Primary Analog Signal Output

3 N/C

4 N/C

5 Ground

6 N/C

7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common

10 Ground

11 Secondary Analog Signal Output / fixed 5.12Vdc *

12 RS-232 RX (receive) or RS-485 — *

13 Power Supply (+Vdc)

14 RS-232 TX (send) or RS-485 + *

15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on Alicat devices, may not be present on host wiring.
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Additional Information for Alicat CSA and ATEX Approved Devices
See the following page for Special Conditions regarding the use of these units!

ce&xusc @,

EEx nAlIC T4
Class |, Div. 2 Group A, B, C and D T4

24 Vdc, 0.800A max
Class |, Zone 2 AEx nAlIC T4
WARNINGS:

EXPLOSION HAZARD — DO NOT DISCONNECT WHILE CIRCUIT IS
LIVE UNLESS AREA IS KNOWN TO BE NON-HAZARDOUS.

EXPLOSION HAZARD - SUBSTITUTION OF COMPONENTS MAY
IMPAIR SUITABILITY FOR CLASS |, DIVISION 2.

All Alicat CSA/ ATEX approved devices are equipped with a locking 6 pin industrial
connector. The power and signal connections are shown below.

Male Connector: Cable Female Connector: Device

Pin | Function

Power In (+)

RS-232TX

RS-232RX

Remote Tare Meters (Ground to Tare)
Analog Set-Point Input (Controllers)
5 |Ground (common for power,
communications and signals)

6 |Signal Out (Voltage or Current as
ordered)

Industrial Connector Overall Clearance

AWM=

1.817

Minimum
Removal
Clearance

N

1<)

@

N
Cable Bend

1.602

Min. Clearance w/

Clearance Requirements for
Industrial Connector
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USE of Alicat instruments (M, MW, MS, MC, MCW, MCS, MCR, MCRW, MCRS, P, PS, PC,
PCS, PCR and PCRS product families only) in Class 1 Division 2 applications.

locations as defined by Class 1 Division 2 Group A, B, C and D T4.

CSA certification is indicated by the product label as shown below and
not by the statements in this, or any accompanying documentation.

: CSA certifies the use of this product for general use as well as use in hazardous

Special Conditions:
To comply with CSA certification the following information is included in the product literature:
o When equipment is properly labeled, it is suitable in Class |, Division 2, Group A, B,
CandD, T4
o Tamb. -40°C to +50°C
e Electrical Rating 24Vdc, 0.800A max
e Instruments shall be powered by a CSA certified, UL listed, Class Il external power
supply suitable for the application
e Instruments shall be housed in an enclosure with a minimum IP54 rating or location
providing equivalent protection
e Instrument’s final approval shall be provided by the local authority having jurisdiction

Z=ALIGAT

SCIENTIFIC

CEN3G

EEx nAIIC T4
Class |, Div. 2 Group A, B, C and D T4
24 Vdc, 0.800A max
Class I, Zone 2 AEx nA lIC T4

X — See manual for special conditions

WARNINGS:
EXPLOSION HAZARD — DO NOT
DISCONNECT WHILE CIRCUIT IS LIVE
UNLESS AREA IS KNOWN TO BE NON-
HAZARDOUS.
EXPLOSION HAZARD — SUBSTITUTION
OF COMPONENTS MAY IMPAIR
SUITABILITY FOR CLASS |, DIVISION 2

Alicat Scientifc, Inc. N
Tucson, AZ USA sp. §
Tel: 520-200-6060 B =

www.AlicatScientific.com

USE of Alicat instruments (M, MS, MC, MCS, MCR, MCRS, P, PS, PC, PCS, PCR and PCRS
product families only) in applications requiring ATEX Certification.

Properly labeled Alicat instruments comply to the following ATEX standard:

@II 3 GEExnAIIC T4 (-40°C < Ta < +50°C)

The examination certificate was issued by the CSA in accordance with
accepted practices and procedures. This confirms compliance with the
European ATEX Directive or Group Il Category 3G equipment.

ATEX certification is indicated by the product label as shown above and not by the
statements in this, or any accompanying documentation.

Special Conditions:

e Properly labeled equipment is only certified for use in ambient temperatures in the
range of -40°C to +50°C only

e Electrical Rating 24Vdc, 0.800A max

e Instruments shall be powered by a CSA certified, UL listed, Class Il external power
supply suitable for the application

e [Instruments shall be housed in an enclosure with a minimum IP54 rating or location
providing equivalent protection

e Instrument’s final approval shall be provided by the local authority having jurisdiction
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Serial Number:
Model Number:

Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products
described in this manual at any time and without notice. This manual is copyrighted. This document may
not, in whole or in part, be copied, reproduced, translated, or converted to any electronic medium or
machine readable form, for commercial purposes, without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our
literature, it is the complete responsibility of the user to determine the suitability of any product to their
application.

Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that
instruments manufactured by Alicat Scientific (hereinafter referred to as “Product”) shall be free from
defects in materials and workmanship for the life of the Products.
Under this warranty, the Products will be repaired or replaced at manufacturer’s option, without charge for
parts or labor when the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for
any breach by Alicat Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with
the Product operation and installation specifications provided to Buyer verbally or in writing by Alicat
Scientific for the proper and normal use of the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon
Alicat’s examination of Product shall disclose to Alicat’s satisfaction that the Product failure was due
solely, or in part, to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized
repair or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or
incidental damages in connection with, or arising out of, the sale, performance, or use of the Products
covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life
support applications or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no
obligation or liability shall arise or grow out of Alicat’s rendering of technical advice in connection with
Buyer’s order of the Products furnished hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the
Product with available replacement parts or upgrade the Product to a current, commercially available
version of the original Product. Should upgrading the Product be deemed necessary by Alicat, Buyer
hereby agrees to pay an upgrade fee equal to seventy percent of the retail value of the replacement
Product. Alicat Scientific hereunder makes no claim that replacement Products will look, function or
operate in the same or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal
preventative maintenance. Recalibration of Product shall not be treated as a warranty service unless
recalibration of Product is required as the result of repairs to Product pursuant to this Warranty. Failure
of Buyer to send Product to Alicat Scientific for recalibration on a yearly basis after a period of 36 months
from date of manufacture will remove any and all obligations regarding repair or replacement of Product
as outlined by this Warranty to Buyer from Alicat Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied
warranty of merchantability and the implied warranty of fithess for a particular purpose, and any warranty
against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above
shall be conclusive evidence that the warranty is fulfilled to the full satisfaction of Buyer.
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Conformity / Supplemental Information:

The product complies with the requirements of the Low Voltage Directive 2006/95/EC and the EMC Directive
2004/108/EC and carries the CE Marking accordingly. Contact the manufacturer for more information.




Gas Viscosity, Density and Compressibility:

Absolute Density ** Compressibility Absolute Density ** Compressibility
Viscosity* 25°C 25°C Viscosity* 25°C 25°C
25°C  14.696PSIA 14.696PSIA 25°C  14.696PSIA 14.696PSIA

0 Air Air | 184.8989 1.1840 0.9997 20 | 75%Ar/25% CO2 | C-25 | 206.9763 | 1.6766 0.9987
1 Argon Ar | 226.2399 1.6339 0.9994 21 | 90% Ar/10% CO2 | C-10 | 218.6026 | 1.6509 0.9991
2 Methane CH4 | 110.7595 0.6569 0.9982 22 | 92%Ar/8%C0O2 | C-8 | 220.1352 | 1.6475 0.9992
3 | Carbon Monoxide | CO | 176.4933 1.1453 0.9996 23 | 98%Ar/2%C0O2 | C-2 | 224.7148 | 1.6373 0.9993
4 | Carbon Dioxide | CO2 | 149.3184 1.8080 0.9950 24 | 75% CO2/25% Ar | C-75 | 168.2250 | 1.7634 0.9966
5 Ethane C2H6 | 93.5412 1.2385 0.9924 25 | 75% Ar/25% He |HE-75| 231.6056 | 1.2660 0.9997
6 Hydrogen H2 89.1535 0.08235 1.0006 26 | 75% He/25% Ar |HE-25| 234.6860 | 0.5308 1.0002
7 Helium He 198.4561 0.16353 1.0005 90% He / 7.5% Ar |
8 Nitrogen N2 | 178.0474 1.1453 0.9998 27 2.5% CO2 A1025| 214.9760 | 0.3146 1.0003
9 | Nitrous Oxide | N20 | 148.4124 | 1.8089 0.9945 om_.m._wwq%\wm%w ;
10 Neon Ne | 311.1264 | 0.8244 1.0005 28 2% 02 Star29 219.7934 | 1.6410 0.9992
11 Oxygen 02 205.5021 1.3088 0.9994 Stargon® CS
12 Propane C3H8 | 81.4631 1.8320 0.9838 29 | 95%Ar/5% CH4 | P-5 | 223.9106 | 1.5850 0.9993
13 | normal-Butane |n-C4H10 74.0536 2.4493 0.9699 *in micropoise (1 Poise = gram / (cm) (sec)) **Gramsl/Liter
14 Acetylene C2H2 | 104.4480 | 1.0720 0.9928 Reference: NIST REFPROP 9 Database
15 Ethylene C2H4 | 103.1839 1.1533 0.9943
16 iso-Butane i-C4H10| 74.7846 2.4403 0.9735 ,‘
17 Krypton Kr | 251.3249 3.4323 0.9979 Y
18 Xenon Xe | 229.8483 5.3950 0.9947 \‘-
19 |Sulfur Hexafluoride| SF6 | 153.5320 6.0383 0.9887 SCIENTIFIC
Flow Conversions: 7641 N Business Park Drive
SCFM 1.00 = 28.3160 SLPM SLPM 100.00 = 3.5316 SCFM Tucson AZ 85743 USA
SCFH 1.00 = 04719  SLPM SLPM 100.00 = 211.9093  SCFH
SCIM  100.00 = 1.6390 SLPM SLPM  1.00 = 61.0128 sCIm Phone: 888-290-6060 Fax: 520-290-0109
SCIH 1000.00 = 0.2732 SLPM SLPM  1.00 = 3660.7688 SCIH

alicat.com

A HALMA COMPANY
The Fastest Flow Controller Company in the World!




